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Foreword: 
 

 

This manual is developed as part of the ‘Pilot Urban Asset Management System in Kampot’. 

This pilot project is part of the second Greater Mekong Sub-region (GMS) Corridor Towns Development 

Project implemented by the Ministry of Public Works and Transport under Loan agreement 3314-CAM 

with the Asian Development Bank. 

The Project Management and Implementation Support, Detailed Design and Construction Supervision 

(Package 1) and Capacity Building (Package 2) are executed by NJS Co., Ltd, Japan in Joint Venture with 

CEST Incorporated, and Key Consultants (Cambodia) Ltd. 

This manual is intended as guideline for participants of the training of the BRUTIS (Best Rational Urban 

Tech Information System) application tools for urban infrastructure management.   

The manual has been prepared and made available to the ‘Pilot Urban Asset Management System in 

Kampot’ project by Dr. Hendrik Kingma, Engineer/ Software Developer and owner of the BRUTIS 

application tools for urban infrastructure management. 
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1 Introduction 
 

Welcome to the Urban Drainage Management System BRUTIS, developed by https://www.riodesk.com, 

based on the best management practice of sewage and drainage professionals in the Netherlands. 

 

BRUTIS is an abbreviation for Best Rational Urban Tech Information System. In BRUTIS is drain and 

sewer management an integral part of the management of all other objects in the urban space. 

 

This software allows you to collect data, investigate conditions, perform assessments, plan, implement 

and improve drain and sewer systems. Based on the European Standard EN 13508-2 

 

Contents 

• General philosophy of BRUTIS 

• Scope 

• Overview of this manual 

 

1.1 General Philosophy 

The general philosophy of BRUTIS is simplicity. 

 

The system is easy to install because it consists of one executable: BRUTIS64.exe, and a  

NCSEcw.dll file for viewing ECW aerial photos. You only have to copy BRUTIS64.exe and 

NCSEcw.dll file to your MS Windows operating system.  

 

The user interacts with BRUTIS through a graphical user interface (GUI). The main focus in the 

design of the interface was to offer an attractive geographical toolbox for rational management 

of urban drainage and sewer systems. The interface provides for the following functions: 

• File management 

• Read data from GIS, like Geo-Database, Shape-, CSV1- or Internet Files,  

• Global Positioning (GPS) 

• Data entry and editing 

• Assessment tools 

• Reporting facilities 

 

The data is stored in a work-file or in a database. Possible databases are: Oracle, MS SQL-Server 

or MS Access.  

 

After defining a username and password in Oracle or MS SQL-Server or creating a database file 

(.mdb) with MS Access the user connects with the database with the standard Open Data Base 

Connectivity (ODBC) functions supplied on all MS Windows computers. 

 

The user is able to experiment, prototype or collect data in a mutation-file. The database 

administrator transfers the data from mutation-files or data read from GIS to the database with 

the BRUTIS buttons. 

 

 
 
1 CSV is an abbreviation for comma separated values, The shapefile format is a geospatial vector data format for GIS. 



Riodesk 

 
 
 

S
C

O
P

E
   

U
s
e
rs

 M
a

n
u
a
l 

P
A

G
E

 

2 

After data transfer the database BRUTIS creates automatically a work-file with the database 

data after the transfer. BRUTIS displays the data in the work-file in the graphical user interface 

(GUI). With the work-file and mutation-file you can use BRUTIS outdoor for data collection and 

investigation without database connection. 

 

1.2  Scope 

BRUTIS is applicable for urban drain and sewer systems, which operate under gravity or pressure, from 

the point where the sewage leaves a building or roof drainage system, or enters a road gully, to the 

point where it is discharged into a treatment works or receiving water. 

 

Urban drainage and sewer systems consist of several objects, for example: 

• Conduits: 

o drainage canals; 

o pipes; 

o culverts in drainage canals; 

o etc. 

• Nodes: 

o  

o Manholes; 

o gates in outlets to rivers; 

o pumping stations; 

o reservoirs or retention basins; 

o etc. 
 

The most important data input for the management system is: 

• What do we have (urban drainage system) 

• What is the performance (does it meet design standards) 

• What is the level of physic condition (damages) 

• What is the level of maintenance (sedimentation) 
 

For a proper management of the entire system, it is of great importance to have access to a reliable 

database in which data of the entire system are included. 

Even more important is to regularly update this database. The purpose of the database is having actual 

data for investigation of the hydraulic, structural and operational performance and to make yearly and 

a long-term planning for maintenance and investments. 

 

BRUTIS is the interface between user and database. 

 

1.3 BRUTIS Documentation 

The BRUTIS documentation is arranged in the following two categories: 
 

Documentation Description 

  

User’s Manual This manual provides installation instructions on how 

to get started and collect data with BRUTIS. 

Reporting and Planning Guide This manual is guide to using BRUTIS for reporting the 

performance, check the physic condition and the level 
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of maintenance, and perform costing and planning. 
 

1.4  Overview of This Manual 

This Users manual is the primary piece of documentation on how to use BRUTIS for: 

• getting started 

• the collection of available data; 

• investigation and collection of missing data; 

• implementation of the data in a management database. 
 

In appendix A is documented how to change the behaviour of BRUTIS. The CSV and mutation-file 

coding system is defined in appendix B. The coding system for the registration of the drainage condition 

is defined in appendix C.  Examples of how to import survey data is reported in appendix D. The BRUTIS 

database is defined in appendix E 
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2 Terms and definitions 
For the purpose of this manual, the following definitions apply: 
 
Canal 
Open water course designed to carry wastewater and/or surface water. 
 
Culvert/Orifice 
Opening in a weir. 
 
Conduit 
Drain, canal, culvert, rising main or pipeline designed to carry wastewater and/or surface water from 
node to node. Each conduit is defined by both node numbers and a conduit id. 
 
Ditch 
Small open water course designed to carry wastewater and/or surface water. 
 
Drain 
Pipeline or ditch, designed to carry wastewater and/or surface water from a source to a sewer. 
 
Drain system 
Network of drains and ancillary works that conveys wastewater and/or surface water to a cesspool, 
sewer system or other place of disposal. 
 
Gate/Outfall 
Final length of conduit from which sewage is discharged to a treatment works or receiving water. 
 
Gully 
A deep ditch or channel cut in the earth by running water after a prolonged downpour. 
 
Installations 
All extra hardware needed to drive pumps, adjust valves or measure data.  
 
Invert 
Lowest point of the internal surface of the barrel of a pipe or channel at any cross section. 
 
Inspection chamber 
Chamber with a removable cover constructed on a drain or sewer that provides access from surface 
level only, but doe not permit entry of a person. 
 
Manhole 
Chamber with a removable cover constructed on a drain or sewer to permit entry by personnel. 
 
Node 
Manhole, inspection chamber, outfall or other significant intermediate point. Each node is defined by 
X- and Y Coordinates and a unique number. 
 
Pipeline 
Assembly of pipes, fittings, masonry and insitu concrete units and joints between manholes and other 
structures. 
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Pumping station 
Facilities including pumps and equipment for pumping fluids from one place to another. They are used 
for a variety of infrastructure systems that many people take for granted, such as the supply of water 
to canals, the drainage of low-lying land, and the removal of sewage to processing sites. 
 
Receiving water 
Any body of water such as a sea, river, stream or lake as well as an aquifer into which drain or sewer 
systems discharge 
 
Rehabilitation 
All measures for restoring and upgrading the performance of existing drain and sewer systems. 
 
Repair 
Rectification of local damage 
 
Rising main 
Pipe through which sewage is pumped 
 
Sewer 
Pipeline, ditch or canal designed to carry wastewater and/or surface water from more then one source. 
 
Sewer system 
Network of sewers and ancillary works which conveys wastewater and/or surface water from drains to 
a treatment work or other place of disposal. 
 
Spillway 
Final node from which sewage is discharged to a treatment works or receiving water. 
 
Weir 
A dam placed across a canal or in a node to raise or divert the water, or to regulate or measure the 
flow. A weir is defined by a from and to node number. 
 

http://www.answers.com/topic/pump
http://www.answers.com/topic/infrastructure
http://www.answers.com/topic/canal
http://www.answers.com/topic/sewage
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3 Installing BRUTIS (detailed) 
 

Contents 

• Installation. 

• Configure the menu and passports of the objects; 

• How to change the behaviour of BRUTIS by using command line arguments; 

• Create a database and connect with Open Database Connectivity (ODBC); 

• Connecting a GPS Antenna. 
 
In this tutorial it is assumed that you install BRUTIS in the directory: C:\BrutisData 
 

3.1 Installation 

Simply copy the BRUTIS64.exe file to a project directory on your MS Windows operating system. The 
BRUTIS64.exe has an icon as depicted in figure 3.1  
 

 
Figure 3.1 

 

3.2 Configure the menu and passports of the objects 

BRUTIS has many menu options and an extensive data model. To make it easier to use, it is possible to 
disable menu options and hide object data. 
 
Menu option: “Display / Configure menu and toolbar…”, start the window shown in figure 3.2.1 
 
This window lists all menu options, represented by a code, 
menu text and an: 1 or 0. 
 
By changing menu texts, you can, for example, clarify them 
or put them in a different language. With a 1 you ensure 
that the option is present. With a 0 it is not present. 
 
With the [OK] button you save the changes in the file: 
brutis_init.csv, and close the window. With the [Cancel] 
button you close the window without saving the changes. 
 
Restarting the program takes effect the changes to the 
menu. 
 
Brutis_init.csv also stores the data field texts of, among 
other things, the node and pipeline passports. 
You can also open brutis_init.csv with an editor or with MS 
Excel, and directly make changes to the menu and 
passports. 
 

 
Figure 3.2.1 
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Figure 3.2.2. shows an example with a notepad view of brutis_init.csv and the conduit passport, with all 
conduit data fields enabled, by code 1. 
 
CONDUIT,AAD,"From node no.:",1 
CONDUIT,AAF,"To node no.:",1 
CONDUIT,AAZ,"Pipe No:",1 
CONDUIT,ABF,"Date of change:",1 
CONDUIT,ABG,"Time mutation:",1 
CONDUIT,ACJ,"Pipe type:",1 
CONDUIT,ACK,"System type:",1 
CONDUIT,AC3,"Function:",1 
CONDUIT,AC2,"System GWSW:",1 
CONDUIT,AC4,"Operating voltage [v]:",1 
CONDUIT,AC5,"Nominal voltage [v]:",1 
CONDUIT,ACN,"Year of construction:",1 
CONDUIT,ACM,"Year of renovation:",1 
CONDUIT,ACA,"Profile:",1 
CONDUIT,ACG,"Length [m]:",1 
CONDUIT,ACC,"Width [mm]:",1 
CONDUIT,ACB,"Height [mm]:",1 
CONDUIT,AC6,"Bottom width [mm]:",1 
CONDUIT,ACD,"Material:",1 
CONDUIT,AC7,"Material Casing:",1 
CONDUIT,AC8,"Material Lining:",1 
CONDUIT,XAC,"Pressure class:",1 
CONDUIT,XAD,"SDR value:",1 
CONDUIT,ACO,"Joint connection:",1 
CONDUIT,AXP,"joint material:",1 
CONDUIT,ACS,"Foundation:",1 
CONDUIT,ACX,"Basis:",1 
CONDUIT,ACP,"Wall thickness [mm]:",1 
CONDUIT,ACH,"NAP BOB From pit no [m]:",1 
CONDUIT,ACI,"NAP BOB To pit no [m]:",1 
CONDUIT,AKB,"Collection BOB From:",1 
CONDUIT,AKL,"Collection BOB To:",1 
CONDUIT,XAH,"NAP Setting level [m]:",1 
CONDUIT,ACQ,"Hardening type:",1 
CONDUIT,ACR,"Use topsoil:",1 

 

Figure 3.2.2 
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Figure 3.2.3 shows an Example with a notepad representation of brutis_init.csv and the conduit 
passport, in which conduit data fields are disabled, by code 0. 
 
CONDUIT,AAD,"From node no.:",1 
CONDUIT,AAF,"To node no.:",1 
CONDUIT,AAZ,"Pipe No:",1 
CONDUIT,ABF,"Date of change:",1 
CONDUIT,ABG,"Time mutation:",1 
CONDUIT,ACJ,"Pipe type:",1 
CONDUIT,ACK,"System type:",1 
CONDUIT,AC3,"Function:",0 
CONDUIT,AC2,"System GWSW:",0 
CONDUIT,AC4,"Operating voltage [v]:",0 
CONDUIT,AC5,"Nominal voltage [v]:",0 
CONDUIT,ACN,"Year of construction:",1 
CONDUIT,ACM,"Year of renovation:",0 
CONDUIT,ACA,"Profile:",1 
CONDUIT,ACG,"Length [m]:",1 
CONDUIT,ACC,"Width [mm]:",1 
CONDUIT,ACB,"Height [mm]:",1 
CONDUIT,AC6,"Bottom width [mm]:",1 
CONDUIT,ACD,"Material:",1 
CONDUIT,AC7,"Material Casing:",0 
CONDUIT,AC8,"Material Lining:",0 
CONDUIT,XAC,"Pressure class:",0 
CONDUIT,XAD,"SDR value:",0 
CONDUIT,ACO,"Joint connection:",1 
CONDUIT,AXP,"joint material:",0 
CONDUIT,ACS,"Foundation:",0 
CONDUIT,ACX,"Basis:",0 
CONDUIT,ACP,"Wall thickness [mm]:",0 
CONDUIT,ACH,"NAP BOB From pit no [m]:",1 
CONDUIT,ACI,"NAP BOB To pit no [m]:",1 
CONDUIT,AKB,"Collection BOB From:",0 
CONDUIT,AKL,"Collection BOB To:",0 
CONDUIT,XAH,"NAP Setting level [m]:",0 
CONDUIT,ACQ,"Hardening type:",0 
CONDUIT,ACR,"Use topsoil:",1 

 

Figure 3.2.3 

 
 
Brutis_init.csv contains lines for: 
 

MENU Menu texts, on/off 

OBJECT Object data field texts, on/off 

NODE Node data field texts, on/off 

GULLY Gully data field texts, on/off 

CONDUIT Conduit data field texts, on/off 

PUMP Pump data field texts, on/off 

VALVE Valve data field texts, on/off 

SENSOR Sensor data field texts, on/off 

INST Installation data field texts, on/off 

WEIR Weir data field texts, on/off 

ORIF Orifice data field texts, on/off 
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3.3 How to use command line arguments (start options) 

You can use command line arguments or define all arguments in start options in a brutis_init.xml 
configuration file, to start your BRUTIS application with special behaviour. 
 
In appendix A you will find a listing of all possible start options. 
 
Go to Windows menu: "Start -> Run" and enter the file path and file name of the application, followed 
by the command line arguments. For example: 
 
 
 
 
 
(Including the quotation marks). In this example the file path to the installation directory is 
C:\BrutisData, the application file name is BRUTIS64.exe, and the command line arguments we are 
using are: 

• utm=BR 

• init=kc_init.xml 
 
Between arguments you should place a comma (,) directly between each command line argument that 
you wish to use. 
 
Option: utm, defines latitude/longitude to UTM coordinate translation type. The default is: 0. 
 
Option: init, defines the name of the configuration file where all start options are defined. The default 
is: brutis_init.xml. Use menu option: "Tools / Start Options…", to change the options in the 
configuration file. 
 
If you regularly wish to start your application using command line arguments then you can also create a 
shortcut on your Desktop which includes them. To do this, right-click on an open space of the desktop 
and choose "New -> Shortcut". Follow the wizard to create the new shortcut. When it prompts you for 
location (not name), type the file path and file name followed by the command line arguments, exactly 
as in the example above. 
 

3.4 Database and ODBC 

BRUTIS interacts with a user-defined database. It uses ODBC, "Open Database Connectivity", to: 

• allow user access to database table and field names; 

• transmit data to the database; 

• execute generated SQL (Structured Query Language) statements. 
 
The user must: 

• create the database; 

• configure: 
o an ODBC "Data Source Name" for the database or  
o define an ODBC driver name as start option or command-line argument.  

 
ODBC allows software products like BRUTIS to interact with a wide variety of Database Management 
Systems (DBMSs). DBMSs like Oracle, SQL-Server and MS Access. The DBMS must provide a software 

“C:\BrutisData\BrutIS64.exe" utm=BR,init=kc_init.xml 

http://kb.mozillazine.org/Installation_directory
http://www.setmachine.com/db.html#createdb#createdb
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0 component known as an ODBC "driver". Most DBMSs available on Windows platforms provide ODBC 
drivers.  
 
A simple database with ODBC configuration can be created in a matter of minutes, once you know how. 
 

Creating a database 
The user must provide an empty "target" database. 
 

 
Figure 3.4.1 

 
Here's how to create a database using Microsoft Access: 
 
It is assumed that MS Access is installed on the desktop. 
 

1. Start MS Access 
 

2. Create a blank mdb file.  
 

a. Click on the "New" button and choose the “Blank Database” icon. A “Blank Database” 
dialog will appear as depicted in figure 3.4.1; 

b. Click on the “Browse for a location to put your database”,  button; 
c. Select a location, Save as type: “Microsoft Access Databases (2002 – 2003 format) 

(*.mdb). And type a name for your new database. The new database will have a default 
name, Database1.mdb and it is recommended that you change this name to reflect 
your data. In this example we give the name: Pilot_Data_KC.mdb. Create the database 
in the assumed directory: C:\BrutisData 

 
3. Exit MS Access. 

 

http://www.aspfree.com/##
http://www.aspfree.com/##
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1 The database: Pilot_Data_KC.mdb is created in the directory: C:\BrutisData. At this point the database 
is empty. The database has no tables, queries, forms, reports, and so forth. 
 
BRUTIS will create the database tables automatically when it connects to an empty database and wants 
to check the data. 
 
Configuring an ODBC Data Source 
The user must configure an ODBC "Data Source Name" (DSN) for the database. This is a simple process 
of choosing a label and applying it to the database. A Windows program: the ODBC Data Source 
Administrator, is used for this purpose. 
  
The ODBC Data Source Administrator program can be started in several ways: 

• choosing BRUTIS menu option: "Tools / ODBC Administrator"; 

• clicking on the Windows Control Panel "ODBC" icon;  

• entering "ODBCAD32" and the Windows command prompt;  

• consulting Windows Help and Support: search on "ODBC". 
 
These options are presented because the ODBC Data Source Administrator can be difficult to locate on 
some systems. The program's file name is ODBCAD32.EXE, and it is often (but not always) in the 
\WINDOWS\SYSTEM32 directory. Contact www.riodesk.com if you have trouble finding it.  
 
After starting the ODBC Data Source Administrator, a dialog will appear as depicted in figure 3.4.2. 
 
 

 
Figure 3.4.2 

 
 
Once you are running the ODBC Data Source Administrator choose the "Add" option. Do add a new 
Data Source:  
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2  
A dialog will appear as depicted in figure 3.4.3. Choose the appropriate ODBC driver for your DBMS: 
 

 
Figure 3.4.3 

 
The next dialog, which is DBMS-specific, allows you to specify the Data Source Name and the location 
of your database. 
 

 
Figure 3.4.4 

 
Enter the data source name and the description of the database. In figure 3.4.4: “PilotKC” and “Urban 
Drainage Data Pilot_Data_KC” 
 
After choosing the Database Select option a dialog will appear as depicted in figure 3.4.5. Select with 
this dialog the earlier created database file. 
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3 

 
Figure 3.4.5 

 
Once you have specified the Data Source Name, the driver, and the database location you are ready. 
 
 

3.5 Connecting a GPS antenna 

 
For Global Positioning with BRUTIS, you can use: 

• The Garmin GPS 18x2 antenna connected to an available USB port as depicted in figure 3.5.1; 

• A GPS antenna using NMEA-0183 protocol connected to an available serial port; 
 

 

 
Figure 3.5.1 

 
 
2 The Garmin USB 18x is no longer supplied by Garmin 
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4  
Garmin GPS 18x 
Drivers are available on www.garmin.com for use on Windows computers.  
 

 
 
GPS antenna using NMEA-0183 protocol 
For working with these antennas, you need to start BRUTIS with the “gpsport” command line argument 
with the serial port used for the connection. For example: 
 
 
 
 
Don’t forget the double points “:” after the port name. 
 
When the command line argument is specified, BRUTIS reads automatically the data received through 
the defined serial port. 
 
 
Global Positioning 
BRUTIS starts reading the GPS antenna: 

• After start-up and antenna is connected 

• choosing BRUTIS menu option: "Display / Find GPS Position" 

• choosing BRUTIS menu option: "Display / Display Options" 
 
BRUTIS checks the serial port for valid data if the command line argument: “gpsport”, is specified. If not 
specified BRUTIS checks the USB port if there is a Garmin USB 18 connected. 
 
After start-up BRUTIS searches automatically a connected antenna. When a antenna is found BRUTIS 
displays a notification dialog as depicted in figure 3.11. After clicking OK BRUTIS starts reading the 
position data.  
 
Direct after start up: 

• The antenna acquires satellites. The correct position will not be found immediately. The type of 
position fix will be 1. 

• BRUTIS displays the GPS position at the last known position when it had a good satellite 
reception. (When the fix was 2 or 3). 

 
Wait until BRUTIS displays a fix 3 position quality. In most cases the acquire time takes less than a 
minute. (Although the initial satellite acquire out of the box takes about ten minutes.) 
 

 
Figure 3.5.2 
 
Check your current position on overhanging trees, rocks or buildings, if no correct position data is 
found. 

“C:\Kikker\Kikker.exe" gpsport=COM1: 

http://www.garmin.com/
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5  
When the GPS antenna has a good reception it sends the latitude and longitude to BRUTIS. BRUTIS 
converts the received data to UTM zone and coordinates. BRUTIS zooms in on the location and displays 
the coordinates and received information from the antenna as depicted in figure 3.5.3. 
 

 
Figure 3.5.3 
 
GPS Antenna information: 

• Zone: The UTM zone notification and used translation type (WGS-84 in this example) 

• X,Y: The UTM coordinates of the zone in meters 

• UTC: UTC Time 

• LAT: Latitude in degrees minutes and seconds 

• LON: Longitude in degrees minutes and seconds 

• MSL: Height of WGS84 ellipsoid above Mean Sea Level MSL (meters) 

• FIX: Type of position fix (0 = no fix; 1 = no fix; 2 = 2D; 3 = 3D) 

• EPE Estimated position error (meters) 

• EPH Estimated position error, horizontal only (meters) 

• EPV Estimated position error, vertical only (meters) 

• GEO Altitude above WGS 84 ellipsoid (meters) 

• ALT Height of WGS84 ellipsoid above MSL (meters) 

• V-E Velocity east (meters/second) 

• V-N Velocity north (meters/second) 

• V-U Velocity up (meters/second) 
 
The usage of the default (WGS-84) parameters for latitude/longitude conversion to UTM zone and 
coordinates is possible via the usage of command line arguments (See chapter 3.3). 
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4 Getting started 
 

Contents 

• Installing BRUTIS (global) 

• Starting BRUTIS 

• Opening files and importing Data 

• Display options 
 

4.1 Installing BRUTIS (global) 

Simply copy the BRUTIS64.exe file to a working or project directory on your operating system. The 
BRUTIS64.exe has an icon as depicted in figure 3.1. In chapter 3 you will find detailed installation 
information.  
 

4.2 Starting BRUTIS 

Double-click on the BRUTIS Icon.  
 
When you first start BRUTIS, you will see the welcome dialog as shown in figure 4.2.1 
 

 
Figure 4.2.1 

 
 
The welcome dialog has the following 4 tabs: 
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7 • Directory, you can select a work-file in the folder where BRUTIS64.exe is installed or in the 

folder defined behind command line argument: address; 

• File, you can select a work-file, or other suitable file type, from your computer; 

• Database, you can connect to a database, after which the program will build a work file from 
this database and display the data from this file; 

• Protocol, you can connect to the BRUTIS Cloud, after which the program downloads a work-file 
and displays the data from this file; 

 
Set the correct UTM Zone for displaying the correct coordinate system and the maps from 
openstreetmap.org. The correct UTM zone for Cambodia is: 48N.  
 
The [OK] button starts the creating of a working fle (when tab: Database or Protocol, is selected) en 
displays the data in the work-file or other selected file type.  
 
The [Exit] button exits the program. 
 
Database 
This tab is used for connecting with a database. When you want to connect to an Oracle or SQL-Server 
database you need to type your UserName, PassWord and ODBC source name. When connecting with 
a MS-Access file you only need to type the ODBC source name (See chapter 3.3 or figure 3.5). 
 
For example, type in the ODBC Source name created in chapter 3.5. And click on: On-Line 
 
BRUTIS checks if the database has tables for strategic, tactical and operational planning. If not, you will 
see a dialog as depicted in figure 4.2  
 

 
Figure 4.2 

 
Set the check-box on for automatically installing these tables. And Click on OK. 
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BRUTIS creates automatically new work-files if the database contains drainage data. 
 
If the database has no data the dialog in figure 4.3 appears.  
 

 
 
Klik [Yes] to change tab, to select a work-file. 
 
 
Display data without Global Positioning System (GPS) 
BRUTIS displays data from work-files if available. If there are no work-files available a window will 
appear as depicted in figure 4.3. 
 

 
Figure 4.3 

 
Display data with GPS 
BRUTIS automatically starts reading the GPS antenna if the GPS antenna is connected (see chapter 3.5) 
 
When an antenna is found BRUTIS displays a notification dialog as depicted in figure 3.5.2. After clicking 
OK BRUTIS starts reading, and displays the last known position when the GPS fix is 1. Wait for a fix 2 or 
3. Fix 3 normally gives an acceptable actual position. In most cases the acquire time takes less than a 
minute. (Although the initial satellite acquire out of the box takes about ten minutes.) 
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5 Opening and importing files 
 
BRUTIS is a multi-windows program. Each window represents a file. Each file represents an Urban 
Drainage Network. 
 
The first window (the start-up window) is called: “First data management”. In this window you can 
create or import a mutation-file for experimenting, prototyping or collecting data. 
 

Contents 

• Open and read from files 

• Import data from files 

• Mutation (global) 

• Save in work file or database 

• Initial creating tables and data storage to database  
 

5.1 Open and read from files 

Opening and reading a file can be started in several ways: 

• choosing BRUTIS menu option: "File / Open"; 

• clicking on the toolbar button: “Open”. 
 
BRUTIS displays the data from the opened files in a new window with the filename as window title. An 
exception is the opening of a BRUTIS data file (.KIK) with nodes or gullies. When the “First data 
management” window has no nodes or gullies the data will be imported in this window without the 
creation of a new window. 
 
BRUTIS opens, reads and displays data from files with the extensions: 

• KIK  BRUTIS data file with Urban Drainage Network in Comma Separated Format (CSV); 

• SUF Inspection data (Used in the Netherlands); 

• CYC Cyclone hydraulic calculation data; 

• HYD Sobek hydraulic calculation data; 

• TXT Mouse hydraulic calculation data (old format); 

• UND Mouse hydraulic calculation data (only objects); 

• MEX Mouse hydraulic calculation data (objects and catchments); 

• DSD InfoWorks hydraulic calculation data (old format). New format via importing CSV files 
choosing menu option: “Import / CSV Object Data…); 

• BMP Bitmap. Geo referenced when: “.bpw” world file available in same directory; 

• JPG Or JPEG. Geo referenced when: “.jgw” world file available in same directory; 

• PNG Portable network Graphics. Geo referenced when: “.pgw” world file available in same 
directory; 

• EMF Enhanced MetafIles and Windows Metafiles 
 

5.2 Import data from files 

Importing data can be started choosing BRUTIS menu option: "Import" followed by one of the following 
options: 

• From Database 

• GML, DXF or SHP topography 

• ECW, BMP, PNG, JPG, GIF, ICO, EMF or WMG Image 

• Exchange format Inspection File / Start 
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0 • CSV Object Data / Start. 
 
From Database 
This option is used if you want to import drainage data from database: 

• to add the data to the current data 

• replace the current data with data from the database. 
 
If not connected a dialog will appear as depicted in figure 5.2.1 
 

 
Figure 5.2.1 

 
After connecting to the database, the window according to figure 5.2.2 appears, in which it is indicated 
which management system has been found. 
 

 
Figure 5.2.2 

 
After which a new work file is created behind the scenes. And a window (figure 5.2.3) appears asking if 
you want to add the found data or replace the current data. 
 

 
Figure 5.2.3 
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After which BRUTIS displays the data from the work-files as depicted in figure 5.2.4.  
 

 
Figure 5.2.4 

 
GML, DXF or SHP topography 
BRUTIS has the ability to import multiple KML files (.kml), GML files (.gml), cad files (.dxf) and ESRI 
shape files (.shp). The user uses the topography for: 

• display behind the urban drainage; 

• convert data from geometry to urban drainage; 

• digitizing data from the topographic. The user has snap options on circles and near and 
endpoints of lines; 

• converting straight conduits between nodes to curved/bended conduits. Useful for digitizing 
rising mains; 

• registration of catchments; 

• divide the catchments areas to the nodes by creating Voronoi Diagrams; 

• selecting conduits in shapes (.shp) or closed polygons (.dxf). 
 
After selecting the: “Import / GML, DXF or SHP 
topography”, option the user selects a file with the 
import DXF or SHP file dialog.  
 
If a cad file (.dxf) is selected a dialog, depicted in figure 
5.2.5 will appear.  
 
 
 

For normal use a user don’t has to 
click on the checkboxes in the 
dialog depicted in figure 5.9. 
 

 

 
Figure 5.2.5 
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2 If a ESRI shape files (.shp). is selected a dialog, 
depicted in figure 5.2.6 will appear. 
 
Appendix D describes an example of how to 
convert data from geometry to the BRUTIS 
Model. 
 
For very large topographies, building the 
display can take a very long time. This can be 
accelerated by giving the “slowtopo” option a 
zoom factor between 0.1 and 2, via the menu 
option: Tools -> Start options. For example, 
slowtopo=1. This option only displays the 
topography at the specified zoom factor. 
 
 
 
 
 
 
ECW, BMP, PNG, JPG, GIF, ICO, EMF or WMG Image 
Another option available to users is the ability to add background images for display behind the urban 
drainage schematic.  
 
Importing ECW data is the best solution to display background maps. 
 
In other formats the software will automatically look for a companion file to the image, called a world 
file.  This file contains information about the image, including the coordinate system and the extents of 
the image. If the world file is not available a dialog will appear as depicted in figure 5.2.7. in this dialog 
the user enters the coordinates of the pictures and the x-y scale factors.  Several graphical formats are 
supported for background maps , including: .bmp and .jpg/jpeg. 
 
An example of the usage of background images is depicted in figure 5.2.8 
 

 
Figure 5.2.7 

 
Menu option: “File \ Create GeoReference File”, enables the user to create a world file by digitizing 2 
points with known coordinates on the background image. 
 

 
Figure 5.2.6 
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Figure 5.2.8 
 
 
Exchange format Inspection File 
The exchange of inspection data is based on the NEN-EN 13508-2+A1 Investigation and assessment of 
drain and sewer systems outside buildings - Part 2: Visual inspection coding system. 
 

The user adds inspection data from standard inspection file formats to the urban drainage schematic. 
The software checks the inspection data end connects the data to the conduits. BRUTIS uses the 
inspection data for: 

• automatic reviewing and selecting conduits on repair or rehabilitation measurements, with 
decision support system (DSS);  

• displaying location of damages in conduits in combination with video and photographic details. 

• manual reviewing conduits and planning of tactical measurements 
 
Inspection data can also be imported via CSV or mutation-files.  
 
An example of the usage of inspection data is depicted in figure 5.2.9. 
 
 
CSV Object Data 
This option allows you to import spreadsheet data. The spreadsheet must be in the Comma Separated 
Value (CSV) format. Most spreadsheet programs and some hydraulic calculation programs like 
InfoWorks and Sobek can read and write this format. These programs convert existing listings of data to 
CSV format, which you import in a BRUTIS. 
 
The import of CSV data is documented in appendix B. Appendix D reports an example.  
 
The “Import / CSV Object Data” option has a direct link with the available “Export / CSV Object Data” 
options. All exported CSV data can be imported directly in BRUTIS, because the CSV headers area 
known. For a complete overview of the export and import possibilities you should try all options under: 
“Export / CSV Object Data”, and open the resulting CSV export files in a spreadsheet program. 
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Figure 5.2.9 
 
 
 
If the CSV Object data does not have known headers, the 
program asks what kind of objects it concerns. According to 
the window in figure 5.2.10. 
 
 
After choosing the object type, the appropriate window 
appears to indicate how to copy the CSV data into the 
BRUTIS model.  
 
In figure 5.2.12. the window of the nodes and in figure 
5.2.13 the window of the pipes. 
 
The “how to copy” data is saved in an integration file, for 
use next time. With the window shown in Figure 5.2.11 
 

 
 

Figure 5.2.11 

 
 

 
Figure 5.2.10 
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5 In figure 5.2.12. the window of the nodes and in figure 5.2.12 the window of the pipes. 
 
 

 
Figure 5.2.12 
 

 
Figure 5.2.13 
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6 5.3 Mutation (global) 

With the option “Mutation / Show mutations from File” a user creates a new, or open and read an 
existing mutation-file. After selecting this option, a dialog will appear as depicted in figure 5.3.1 
 

 
Figure 5.3.1 

 
All data in the mutation-file format is coded in a header line. An example of a file in this format is given 
in figure 6.1.1 
 
Because BRUTIS does write data directly in a mutation-file and not directly in the database the user 
cannot damage important data. The user is able to experiment, prototype or collect data in a mutation-
file without database connection.  
 
In a shortcut you can use the command line argument: “mut=” to start your BRUTIS with a mutation-
file (See chapter 3.2). Or define a mutation file name after start option mutfile. To make life easier 
when a user collects or digitizes data. 
 
For example, in the command-line: 
 
 
 
 
 
For example, in the window after menu option: 
“Tools / Start options”, depicted in figure 5.3.2. 
 
 
 
 

“C:\BrutisData\BrutIS64.exe" mut=C:\BrutisData\mutation_01.mut 

 
Figure 5.3.2 
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7 Create a new mutation-file 
Type in the: “Make mutation-file or open existing", dialog the name of the file. After clicking OK, a 
dialog will appear as depicted in figure 5.3.3. In this dialog the user defines the header information of 
the mutation-file. 
 
Open and read an existing mutation-file 
After opening an existing file BRUTIS changes the data initially read from work-files or a BRUTIS file, 
with the data read from the mutation-file. When no initial data is read all data is new. 
 

 
Figure 5.3.3 

 
After creation / opening 
BRUTIS writes all inputted data directly in the mutation-file and saves the data automatically. 
 

5.4 Save to work file or database 

Save the BRUTIS model to a work file or database after mutation or converting data from files. 
 

• Save to a work-file via menu option: “File / Save As / Work-File”, so that the data obtained can 
be opened and viewed directly from the work file, immediately from now on. 

 

• If a database is available. Via menu option: Mutation / Move mutation to database / Check 
mutations.  After entering the database connection data, BRUTIS connects to the database and 
checks whether the changes can be implemented. If the data is acceptable menu option:  
Mutation / Move mutation to database / Move mutation to database, becomes available to 
store the data in the database. 
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8 Transferring data to the database 
When a mutation is finished the database 
administrator transfers the data from the 
mutation-file to the database with the option: 
“Mutation / Move Mutations to database / 
Check mutations”. 
 
After selecting this option the following 
communication between user and software is 
started: 
 

1. When BRUTIS is not connected to a 
database a dialog will appear as 
depicted in figure 5.4.1. In this dialog 
the user specifies the Data Source 
Name, and username/password if 
needed, and clicks on OK. 

 
2. BRUTIS confirms the database 

connection with a dialog depicted in 
figure 5.4.2. If no tables for strategic, 
tactical and operational planning are 
found. Confirm this by clicking the 
check box and click on OK. Next time 
these tables are found and the dialog in 
figure 5.4.3 wil be shown. 

 
3. The results of the mutation to database 

check are displayed via notepad, as 
depicted in figure 5.4.4. 
 

4. After step 3 menu acceptable menu 
option:  Mutation / Move mutation to 
database / Move mutation to 
database, becomes available to store 
the data in the database. 
 

5. BRUTIS transfers the data from 
mutation-file to temporary tables in 
the database. In the dialog depicted in 
figure 5.4.5., the user monitors the 
data transfer. 
 

6. After storing the data to the database a 
dialog is shown, figure 5.4.6, asking if 
the work-file has to be updated with 
the database data. 
 

7. After the actions above BRUTIS makes 
a new work-file with actual data from 
the database, and displays the contents 
of the work-file. 
 

 
Figure 5.4.1 
 

 
Figure 5.4.2 
 

 
Figure 5.4.3 
 

 
Figure 5.4.4 
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Figure 5.4.5 
 

 

 
Figure 5.4.6 

 
The work-file has the same name as the MS-Access database file, database name using SQL-Server or 
Username using a Oracle database. 
 
Mutations have to be done on the work-file imported from the database. If another work-file is used 
with for example extra data, all these data will also be stored in the database! If the work-file has 
another name the dialog depicted in figure 5.4.7 will be shown.  
 



Riodesk 

 
 
 

S
C

O
P

E
   

U
s
e
rs

 M
a

n
u
a
l 

P
A

G
E

 

3
0 

 
Figure 5.4.7 

 
The same procedure can be followed for an initial database filling.  
 
After the data transfer the mutation-file can be placed in a backup directory. For next updates, inserts 
and deletions of data the user must create a new mutation-file. Don’t go on with a mutation-file with 
transferred data! 
 

5.5 Initial creating tables and data storage to database 

 
Mutation / Move Mutations to Database  / Check Mutations 
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Mutation / Move Mutations to Database  / Move Mutations to Database   
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6 Mutation (detailed) 
 

The creation of mutation-files and the transferring of data from mutation-files to the database are 

explained in chapter 5.4. and 5.5. This chapter explains some actions between creation and transferring 

mutation data to the database. The coding system of mutation-files is based on the European Standard 

EN 13508-2 and is for practical use defined in appendix B and C. 
 

Contents 

• Mutation files 

• Conduit Inspection 

• Delete Conduit 

• Insert Conduit 

• Insert Nodes 

• Gully Cleaning 
 

6.1 Mutation Files 

For updating, deleting or inserting data the user must open a mutation-file. With the option “Mutation 
/ Show mutations from file” a user creates a new mutation-file or open and read an existing mutation-
file. After selecting this option as dialog will appear as depicted in figure 5.3.3. 
 
All data in the mutation-file format is coded with a header line. An example of a file in this format is 
given in figure 6.1.1. 
 

 
Figure 6.1.1 
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6 The connecting with images or videos data is defined in the data under the CSV-header beginning with 
the text: #I-RIB, defining the name of the mutation file.  The mutation filename without extension: 
“.mut”, defines the location of images, video’s and measured data.  After reading these lines BRUTIS 
searches initially for images and videos in the directory: “C:\BrutisData\mutation_01”. A user overrules 
the searching in this directory by using the command line argument: “images=”. (See chapter 3.2). 
 
For example: 
 
 
 
 
 
 
 
 
 
Because BRUTIS writes data directly in a mutation-file and not directly in the database the user can not 
damage important data. The user is able to experiment, prototype or collect data in a mutation-file 
without database connection.  
 
When a mutation is finished the database administrator transfers the data from the mutation-file to 
the database with the options: “Mutation / Move Mutations to database / Check mutations“, 
followed by: “Mutation / Move Mutations to database / Move Mutations to database “. 
 

6.2 Conduit Inspection 

With the options under “Cleaning and Inspection” a user adds inspection data to urban drainage 
schematic. 
 
 
 
After selecting this option, the software asks to specify the node from where the inspection is started 
and the conduit. Select the conduit by clicking on the conduit near the node from which the inspection 
is started. 
 
A dialog will appear as depicted in figure 6.2. 
 

When there is previous inspection data the data of this inspection is automatically copied in this dialog. 

The user adds, deletes and updates the inspection data based on the European Standard EN 13508-2 

and for practical use on drainage systems defined in appendix C. 
 
Add inspection data by using the next steps: 
 

1. Select a damage observation by expanding the list box behind the Search field, and select from 
the listing the observation. 

 
2. Select the aspect class of the observation by expanding the list box after the Aspect field. 

 
3. Specify the other data belonging to the aspect. 

 
4. Click on Insert to Add the observation to the listing of registered observations 

 

“C:\ BrutisData\Brutis64.exe" images=C:\BrutisData\images 
 
Or 
 
Start option:  images=C:\BrutisData\images 
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7 5. Etc. with next observation 
 

6. Commit the action by clicking: Commit. 
 
A user can select a observation from the registered observations listing and delete the observation by 
clicking Delete or Update by Clicking Update (Button Insert is changed in Update after selecting a 
observation) 
 
In figure 5.14 are the results depicted after entering inspection data. Consult the inspection data by 
selecting the Logbook tab in the Conduit info dialog. 
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Figure 6.2 
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6.3 Insert Nodes 

Open the “Insert Node” dialog, as depicted in figure: 6.3.1, via button:   or menu option: “Add / 
Insert Node”.   
 
Click on the location of the node before entering the dialog for the direct input of the node 
coordinates. If the dialog is already entered the cursor has to be positioned in the X- or Y-coordinate 
field. After the insertion of a node a user can insert the following elements connected to the node: 

• Installations by clicking: “Add / Insert Node Elements / Installation” 

• Pumps by clicking: “Add / Insert Node Elements / Pump” 

• Weirs by clicking: “Mutation / Insert Node Elements / Weir” 

• Orifices by clicking: “Mutation / Insert Node Elements / Orifice” 
 
Between two nodes a user can define a conduit. 
 
After selecting option: “Mutation / Insert Node” a dialog appears as depicted in figure 6.9.  
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Figure 6.3.1 

 
In the dialog the user specifies the node data. The user copies data from another node by clicking on 
the option: “Data / Nodes” and clicking on an existing node. Al data expect the node number will be 
copied in to the dialog. 
 
Specify the position of the node by clicking on a position in the GUI eventual using the snap options. 
When changing a position of an existing node a user must locate the cursor in the X- or Y coordinate 
field. 
 
After saving the data by clicking: OK in the, “Insert node” dialog, the dialog is ready for the next node. 
 
 
 
 
 
 
 
 
 

6.4 Delete Conduit 

With the option “Mutation / Delete Conduit” a user deletes a conduit. Nodes can’t be deleted if there 
are still conduits connected. 
 
After selecting this option the software asks to specify the conduit. Select the conduit by clicking on the 
conduit. 
 
A dialog will appear for confirmation of the removal of the conduit. 
 
Notice the painting of crosses along the removed conduit, depicted in figure 6.4. The conduit will be 
definitely removed after transferring the deletion action to the database. 
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Figure 6.3.1 

 
 
 
 
 
 

6.5 Insert Conduit 

With the option “Mutation / Insert Conduit” a user inserts a conduit. In this chapter we describe the 
insertion of a curved conduit. 
 
After selecting this option, a dialog will appear as depicted in figure 6.4.1 In the dialog the user specifies 
the conduit data. The user copies data from another conduit by clicking on the option: “Data / 
Conduits” and clicking on an existing conduit. Al data expect the node numbers and conduit length will 
be copied in to the dialog. 
 
If the conduit is a straight line between the nodes, the node can be defined by putting the cursor in the 
node number fields and clicking on the nodes in the GUI. 
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Figure 6.4.1 

 

 
 
Follow the next steps for entering a curved line between nodes: 
 

1. Open the “Snap Options” dialog by performing a right button click in the GUI. A menu will 
appear as depicted in figure 6.5. Click “Snap Options”. 

 
2. Start drawing a polygon by performing a right button click in the GUI again. Click “Make 

Polygon”. 
 

3. Click on the Node snap radio button in the “Snap Options” dialog. Like in figure 6.4 
 

4. Click on the from node in the GUI. The software paints the node as if it is selected as depicted 
in figure 6.5 
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5. Click on the Direct snap radio button in the “Snap Options” dialog. 
 

6. Specify the route off the polygon by clinking in the GUI. Stop before reaching the to node 
location. As depicted in figure 6.6.  

 
7. Click on the Node snap radio button in the “Snap Options” dialog.  

 
8. Click on the to node location in the GUI. 
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Figure 6.4 

 
Figure 6.5 

 
Figure 6.6 

 
 
Figure 6.7 

 
The conduit is painted as a curved line. Save the data clicking: OK in the, “Insert conduit” dialog 
 
A dialog will appear as depicted in figure 6.7. for confirmation of the insertion of the conduit according 
the polygon. 
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7 The result is shown in figure 6.8. 

 
Figure 6.8 

 
 
 

6.6 Gully Cleaning 

With the option “Mutation / Gully Cleaning” a user registers the condition of gullies. This option is very 
useful operated by the driver of a gully cleaning vehicle in combination with the GPS Antenna. The GPS 
antenna keeps the location of the vehicle in the mid of the GUI. The drivers places and updates gullies 
in relation with the topography loaded as background. 
 
After selecting this option a dialog will appear as depicted in figure 6.4. In the dialog the user specifies 
the observed condition of gullies. 
 
The data is registered in the mutation-file and after finishing the cleaning round transferred to the 
database. The software generates new work-files as basis for the next cleaning round. 
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Figure 6.10 
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7 Display Options 
 
The BRUTIS Graphical user Interface (GUI) exists off a: 

• pull down menu above; 

• status bar below; 

• caption/legend on the left; 

• tree view on the right; 

• button bar. Each button is also defined in the pull-
down menu; 

• quick menu behind right mouse button click in the 
GUI. 

 

Contents 

• Adjusting the GUI 

• Zoom Options 

• Find Options 

• Adjust Text Formats 
 

7.1 Adjusting the GUI 

The display of each window is defined in the “Display 
Options” dialog. 
 
After clicking the option: “Display / Display Options” a 
tabbed dialog appears as depicted in figure 7.1 and, 7.2. 
 
Display Tab (figure 7.1) 
Adjust the GUI by clicking the check boxes. 
 
 
Conduits Tab (figure 7.2) 
Adjust the thematic display of conduits by clicking the 
radio buttons. If button: Mutations is selected the GUI 
displays deleted conduits (patterned with crosses). 
 
Set the display of conduit text by clicking the conduit text 
radio buttons. 
 
Other Tabs 
As with the conduits, there are tabs for nodes, gullies, 
notifications and objects, like: road section-, construction-
, water-parts, trees, masts. 
 
If a function exists in the data, the tab will be shown. 
 
 
 
 

 
Figure 7.1 
 

 
Figure 7.2 
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7.2 Zoom Options 

In addition to adjusting the GUI there are options available to zoom and pan through the urban 
drainage schematic, background topographic and images. These options can be started from the 
Display menu, the button bar and quick menu behind the right mouse button. 
 
The zoomed schematic is displayed in the upper left corner of the caption/legend area. This area 
contains the conduits of the entire schematic, with a red rectangle defining the area that is zoomed in. 
 
The next zoom options are available: 
 

Zoom In: This option allows the user to zoom in on a piece of the schematic. This is 
accomplished by selecting Zoom In from the Display Menu, Button Bar or Quick menu. 
Place the mouse pointer on the centre of the desired area. Then press down on the left mouse 
button and release the button. This function is repeating when the GPS antenna was not 
connected starting BRUTIS. The function repeats until the user opens the quick menu with the 
right mouse button or selects a new option. 
 
Zoom Out: This option allows the user to zoom out on a piece of the schematic. This is 
accomplished by selecting Zoom Out from the Display Menu, Button Bar or Quick menu. 
Place the mouse pointer on the centre of the desired area. Then press down on the left mouse 
button and release the button. This function is repeating when the GPS antenna was not 
connected starting BRUTIS. The function repeats until the user opens the quick menu with the 
right mouse button or selects a new option. 

 
Zoom All: This option re-draws the schematic or background topographic to its full original size. 
This is accomplished by selecting Zoom All from the Display Menu, Button Bar or Quick menu. 
 
Pan: This option allows the user to move and zoom around in the schematic. This is 
accomplished by selecting Pan from the Display Menu, Button Bar or Quick menu. 
Move the schematic by moving the mouse pointer around wile holding the left mouse button 
down. Scrolling the mouse wheel causes zooming in and out on the centre of the mouse 
pointer. This function is repeating when the GPS antenna was not connected starting BRUTIS. 
The function repeats until the user opens the quick menu with the right mouse button or 
selects a new option. 
 
Zoom Window: This option allows the user to zoom in on a piece of the schematic. This is 
accomplished by selecting Zoom Window from the Display Menu or Quick menu. 
Defining the zoom area is accomplished by placing the mouse pointer in the upper left corner 
of the desired area. Then press down on the left mouse button and drag the mouse to define a 
box containing the desired zoom area. Finally, release the left mouse button and the viewing 
area will display the zoomed in schematic. 
 
Zoom Dynamic: This option allows the user to zoom in and out on a piece of the schematic. 
This is accomplished by selecting Zoom Dynamic from the Display Menu or Quick menu. 
Defining the zoom area is accomplished by placing the mouse pointer in the centre of the 
desired area. Then press the left mouse button down and release the button. Then locate the 
mouse on a corner of the area. Press the left mouse button down and drag the mouse to and 
from the centre. Finally, release the left mouse button and the viewing area will display the 
zoomed in schematic. 
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1 7.3 Find Options 

This option allows the user to have the interface locate a specific feature on the schematic. This is 
especially useful when very large and complex systems are being modelled.  
 
These options can be started from the Display menu, the button bar and quick menu behind the right 
mouse button. 
 
The next find options are available: 
 

Find Node: This option allows the user to specify a node number and zoom in on the area 
around the node. 
 
Find Street: This option allows the user to select/specify a streetname from a listing and zoom 
in on the area around the street. The conduits in the street are painted red. 
 
Find Adres: This option allows the user to select/specify an address from a listing and zoom in 
on the area around the address. The address is painted with a red cross. 
 
Find Node: This option allows the user to specify an EAN Code and zoom in on the area around 
the node with an installation containing the EAN code. 
 

 
In addition to adjusting the GUI there are options available to zoom and pan through the urban 
drainage schematic, background topographic and images. These options can be started from the 
button bar and quick menu behind the right mouse button. 
 

7.4 Adjust Text formats 

This option allows the user to change the text format of node, conduit and topographic text. 
 
These options can be started from the Display / Text Format, menu. 
 
The next find options are available: 
 

Node Number: This option starts a font dialog which allows the user to specify a font, font 
style, size and effect. 
 
Dimensions and Levels: This option starts a font dialog which allows the user to specify a font, 
font style, size and effect. 
 
DXF Text: This option starts a font dialog which allows the user to specify a font, font style, size 
and effect. 

 
The options above do not save for a next session. Use the next start options, available via menu option: 
Tools / Start options, for fixing text heights for subsequent sessions: 
 

txtlv: for the text height in the passports. After changing this option, the program has to be 
restarted before the change has effect; 
txtadr:for the text height of address text; 
txtnod: for the text height of node and object text, like the node number; 
txtstr: for the text height of conduit text, like the conduit dimension; 
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2 txtdxf: for the height of text in  topograp; 

txtdef: for the height of all the other text. 
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8 Data Options 
 
This option allows the user to consult the data of gullies, nodes, conduits and shapes. 
 

Contents 

• Nodes 

• Conduits 
 

8.1 Nodes 

This option allows the user to consult the data of nodes.  
 

1. Start the option Node from the Data menu, the button bar and quick menu behind the right 
mouse button. 

 
2. Place the mouse pointer near the node. Then press down on the left mouse button and release 

the button. 
 

3. a tabbed passport will appear as depicted in figure 8.2. 
 
 
Figure 8.2 

 
4. Change tabs by clicking with left mouse button on a tab. 

 
1. Select a next node as described in step 2 or quit the dialog. 

 
 

8.2 Conduits 

This option allows the user to consult the data of conduits.  
 

1. Start the option Conduit from the Data menu, the button bar and quick menu behind the right 
mouse button. 

 
2. Place the mouse pointer near the conduit. Then press down on the left mouse button and 

release the button. 
 

3. a tabbed passport will appear as depicted in figure 8.3. 
 
 
Figure 8.3 

 
4. Change tabs by clicking with left mouse button on a tab. 

 
5. Select a next conduit as described in step 2 or quit the dialog. 
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Between arguments you should place a comma (,) directly between each command line argument that you wish to use! 
 
File arguments: 

Command Result Example 
address= Directory location BRUTIS will use searching and creating work-files address =C:\BrutisData 

images= Directory location for searching data files connected to inspection data. For 
example images, spreadsheets, pdf and datafiles containing HEC RAS: 
Cross sections, Bridges/Culverts and Lateral structures. 

images=C:\BrutisData\HEC\Tando 

dxf= Start-up with displaying geographical data from defined file. dxf=C:\BrutisData\DXF\Lampriet 

tertier channel.dxf 

rev= Open defined mutation-file after start-up. Display mutation data and set filepointer 
to end of file for adding new mutations. Mutations are written in ASCII format. 

rev=C:\BrutisData\REV\check01.rev 

way= Open defined way-point registration file. GPS way-point data will be written in 
DXF format 

way=C:\BrutisData\WAY\wasehere.dxf 

ribdrive= Defines drive letter of medium with inspection video and photo data. BRUTIS 
replaces the default drive letter with this letter. 

Ribdrive=f 

 
 
Database arguments 

Command Result Example 
rbtype= When exploring a database first look for tables of defined management system. rbtype=DHV 

sectie= BRUTIS selects only data off defined section from DG-DIALOG database. sectie=xx 

timeout= Database selection or and connection timeout parameter in seconds timeout=60 

username= Automatically connect with database with specified username. username=scott 

password= Automatically connect with database with specified password. password=tiger 

datasource= Automatically connect with database with specified data source name. datasource=BRUTIS 

insrdtab Also install Riodesk Database tables and indexes when they do not exist in an 
database with concurrent tables. Default BRUTIS does not install tables in a 
database with existing management tables. 

insrdtab 

nonode Node data will not be checked and saved when transferring data from mutation-
file to database. 

nonode 

nopipe Conduit data will not be checked and saved when transferring data from 
mutation-file to database. 

nopipe 

doadres (new) From version 4.3 and newer by default BRUTIS does not check the database for 
inserting address data. When this option is added to the command line BRUTIS 
will check the database and insert address data.  

doadres 
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GPS arguments 

Command Result Example 
gpsd (new) Get GPS data from gpsd deamon when running BRUTIS under Linux/Wine 

operating system. 

gpsd 

gpsport= Defines serial port for connecting a serial GPS antenna. Antenna must send 
NMEA $GPGAA data line through serial port. Don’t forget the double points “:” 
after the serial port. 

gpsport=COM1: 

frq= Defines repaint frequency in milliseconds. Default is 2000. Only active when GPS 
antenna is connected 

frq=5000 

stp= Defines repaint distance of new GPS location. When GPS position is moved more 
then defined value the data will be repainted. Default distance is 5. m 

stp=2. 

utm= Defines latitude/longitude to UTM coordinate translation type. English versions 
have default type 0. 
 
Possible entries are: 
 0 or WE:  WGS-84 

 1 or AA:  Airy 

 2 or AN:  Australian National 

 3 or BR:  Bessel 1841 

 4 or BN:  Bessel 1841 (Nambia 

 5 or CC:  Clarke 1866 

 6 or CD:  Clarke 1880 

 7:   Everest 

 8:   Fischer 1960 (Mercury 

 9:   Fischer 1968 

 10:   GRS 1967 

 11 or RF:  GRS 1980 

 12 or HE:  Helmert 1906 

 13 or HO:  Hough 

 14 or IN:  International 

 15 or KA:  Krassovsky 

 16 or AM:  Modified Airy 

 17:   Modified Everest 

 18 or FA:  Modified Fischer 1960 

 19 or SA:  South American 1969 

 20:   WGS 60 

 21:   WGS 66 

 22 or WD:  WGS-72 

 

utm=BR 
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Internet arguments (applies only to internet version of BRUTIS): 

Command Result Example 
send= Internet timeout value in milliseconds for sending data  send=60000 

receive= Internet timeout value in milliseconds for receiving data receive=60000 

url= After start-up BRUTIS selects automatically data from internet database and 
opens a default mutation-filename. 
 
Possible entries are: 

1 select only gully data from internet database 
2 select only conduit and node data from internet database 
3 select all data from internet database 
 

url=1 

revurl When reading mutation-file BRUTIS sends all found data to internet database.   

 
Display arguments: 

Command Result Example 
pen= Defines the thickness off the painted conduits. pen=2 

slowtopo= Display DXF of SHP depends on zoom factor. Only the box defined with 
maximum and minimum coordinates of geographical data will not be painted if the 
users zooms out to a certain level. 

slowtopo=4. 

noblock Block (or AutoCAD object data) will not be painted noblock 

dispspu Always display nodetype instead of node number dispspu 

dispnode Always display node numbers dispnode 

 
DXF Export arguments (new in BRUTIS version 4.3): 

Command Result Example 
dimnode=       (new) Defines the height of nodes in to be exported DXF. Default value is 0.8 dimnode=1. 

dimtxt1=       (new) Defines the height of dimension text in to be exported DXF. Default value is 1.3  dimtxt1=1.5 

dimtxt2=       (new) Defines the height of level text (invert, cover or surface levels) in to be exported 
DXF. Default value is 1.2 

dimtxt2=1.3 

dimtxt3=       (new) Defines the height of node numbers in to be exported DXF. Default value is 1.8 dimtxt3=2.0 
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Data manipulation arguments (new in BRUTIS version 4.3): 

Command Result Example 
adjustnode (new) Menu option: “Tools / Get Sewage from DXF” creates new conduits and nodes. If 

an endpoint of DXF/SHP line or poly line is near an existing node. The 
coordinates of that node will be updated with the coordinates of the endpoint of 
the line or poly line.     

adjustnode 

mvhsnap (new) Snaps the found Z coordinate to node Coverlevel (only when snapping to 
midpoint of circle or snapping to GPS position. 

mvhsnap 

stripnull (new) Strips leading zero’s (0) from node numbers when reading work-files or SUFRIB 
inspection files. Don’t use this function when you want to change data in the 
database. 

stripnull 

spurename (new) Sets node types automatically to External Weir, Internal Weir or Pump when 
BRUTIS has evidence that the node is such type. In previous versions this was 
done by default. 

spurename  

begend (new) When defined a polyline/trace conduit trace must be connected to centerpoints of 
nodes. When not connected an error message is displayed. 

begend 

 
Menu and dialog behaviour arguments: 

Command Result Example 
kolkgps Display gully cleaning menu options, adjust and display gully cleaning dialog. 

Search for GPS antenna. 

kolkgps 

slibgps Display gully cleaning menu options, adjust and display gully cleaning dialog. 
Fill the conduit inspection dialog with thickness of sediment aspect data, so the 
operator has only to fill in the thickness. 
Always set default conduit cleaning and search for GPS antenna. 

slibgps 

instgps Display installation mutation buttons in menu instgps 

viewgps Display buttons for outdoor usage in menu viewgps 

revigps Display node and conduit mutation buttons in menu revigps 

autonum BRUTIS automatically numbers nodes when a conduit is added as a polyline. autonum 

norepeat Don’t automatically repeat the zoon in, zoom out and pan zoom functions. norepeat 

sumcatch Before importing catchments data the existing data in memory will not be set to 0. 
So the imported amount of catchments will be added. 

sumcatch 

rioscoop After selecting a conduit the data of the conduit is copied in the file: 
RioscoopKikker.rib in the TEMP directory. 

rioscoop 

glbinsp Only display global inspection aspects. Only implicated in road management 
version of BRUTIS. 

glbinsp 

newcode User can add new descriptions. In English version of BRUTIS always on. newcode 
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This appendix describes the CSV and mutation-file coding system for survey of the inventory and visual 
inspection of drainage systems.  
 
The purpose, method and codes related to the inventory and visual inspection are defined in appendix 
C. 
 
The coding system is used to: 

• transfer data from surveyor to the database of the BRUTIS management system. 

• exchange data between databases. 
 
The BRUTIS mutation system rules the transfer of data from surveyor to the database. The BRUTIS 
CSV file export and import system rules the exchange of data between databases. If the surveyor uses a 
spreadsheet program, the CSV export and import system can also be used to transfer data from 
spreadsheet to the database. 
 
The header information of mutation and CSV file types is coded in appendix C section 3. 
 
Both file formats have a variable length. Only the underlined headers are mandatory. The order of 
headers can be changed. 
 
By default BRUTIS uses a comma as field separator. Changing the field separator is possible by defining 
the next field separator identification on the first line. Before the headers. 
 
#A3=  Example: #A3=;  
 
BRUTIS uses as a rule a decimal point for the decimal point.   
 
BRUTIS uses no surround character (example: “). Normally 
surround characters are used before and after text fields 
where text contains the field separator. As a rule in 
BRUTIS, text fields must not contain field separator 
characters! 
 
Each data row contains a mutation date and optionally a 
mutation time. When importing CSV or mutation data 
BRUTIS checks if the date and time are newer then those 
registered in the data set. If the to be imported data has an 
older date and time the data will not be imported in 
BRUTIS. When transferring to the database this check is 
also performed between data set and database contents. 
 
 

1. CSV files 
An example of a CSV file is given in figure D.4 and D.5.  How to import and export is documented in 
chapter 5.  
 
CSV files contain data of one object type. The data fields are defined by the headers. Each row contains 
one object. The object type is defined by the Field description header. Thanks to the headers and field 
description it is possible to place the contents of CSV files in one file. Like in a file created with the menu 
option: “File / Save As / KIK BRUTIS File”. BRUTIS copies in this file all CSV file data contents depicted 
with menu option: “Export / CSV Object Data”. This is called a BRUTIS file. It has all the data (except 
inspection data when saved in a new window). In fact the BRUTIS file is a whole database in CSV 
format.  
 
Tip: 
First export an example CSV file when creating new CSV files. Use the options depicted with menu 
option: “Export / CSV Object Data”, to get the format of CSV files.   
 
 

Caution! 
 
BRUTIS does not read regional 
settings defined in Microsoft (MS) 
Windows! 
 
In the regional settings the field 
separator and decimal point 
characters are defined. 
 
BRUTIS does not read CSV files if 
MS Excel exports with the wrong 
field separators. Also has MS Excel 
the bad habit of loosing end of line 
field separators when fields near the 
end of line are empty  
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2. Mutation files 
An example of a Mutation file is given in figure 6.1. The creation of mutation-files and the transferring of 
data from mutation-files to the database are explained in chapter 5.1. Chapter 6 explains how to note 
data in the mutation-file and to transfer data to the database. 
 
The first part of the data for a visual inspection or inventory of geometric data contains information about 
the format of the data. Each item of data appears in on a separate record. Each record is prefixed with 
the character # followed by the identification code for the information, the = sign and the code for the 
data. The header information is described in table B.1 
 
 

Identification Description Example 

#A3= The field separator. This is a 
single character used to 
separate the items of data in a 
record 

#A3=, 

#A6= Defines a start id for identifying 
gullies. The first inserted gully 
will have this id. The next will 
have this id +1, the next id +2 
etc.  

#A6=1001 

#B= Identifies the record with 
mutation-file information 

#B=ABI,ABH,ABR,AAM,ABS,ABT,ABU,RBF 

,,,Pilot_Data_KC,,,,2008-11-18 

 

#I= Identifies a record with an object 
and data to be inserted. 

#I=CAA,CAB,CBF,CBG 

Node1,758417.500-615311.000,20081119, 

94130 

 

#U= Identifies a record with an object 
identification and to the to be 
updated data. 

#U=CAA,CAB,CBF,CBG 

Node1,758182.250-615210.500,20081119, 

93943 

 

#D= Identifies a record with a to be 
deleted object. 

#D=CAA,CBF,CBG 

Node1,20081126, 94309 

 

 
 Table B.1 
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This appendix describes the purpose, method and coding system related to the inventory, condition and 
visual inspection of drainage systems.  
 
The coding system is: 

• based on the European Standard EN 13508-2 and is made practical for use with drainage. 

• used to: 
o transfer data from surveyor to the database of the BRUTIS management system. 
o exchange data between databases. 

 
Appendix B describes the BRUTIS mutation and CSV file export and import system which rules the data 
exchange from inspector to the database. Or the exchange of data between databases 
 
The next sections describe the: 

1. Purpose 
2. Method 
3. Codes related to the inventory and condition of drainage 
4. Codes related to the visual inspection (to asses the condition) of drainage 

 

1. Purpose 
The information about the condition of the drainage can be used for the following purposes: 

• to assess the performance of the drainage as part of the development of a rehabilitation plan; 

• to provide information for use in the planning of maintenance activities, e.g. drainage cleaning 
programmes; 

• to investigate specific maintenance or operational problems; 

• the recording of inventory data. 
 
 

2. Method 
Each drain is defined by a conduit between two nodes with a unique number. The geometric data of 
nodes and conduits are defined in table C.1 and C.2. 
 
The nodes define drainage: 

• junctions; 

• changes of cross section, not caused by conditional aspects; 

• changes of material and year of construction. 
 
The conduits define the alignment of the drainage. 
 
Not all the geometric data in the tables is needed for the purpose. The minimum geometric data for 
assessing the condition and needed maintenance and operational problems are painted dark grey 
(orange). The minimum extra geometric data for assessing the hydraulic capacity are painted light grey 
(yellow).    
 
The survey of the geometric data of drainage is done once. The visual inspection of the condition of the 
drainage is done frequently. The frequency is depending of the management goals. 
 
Part of the visual inspection of the 
drainage condition is the registration of 
damages, sediment, obstacles and 
bridges. These conditional aspects 
influence the hydraulic capacity of the 
drainage and have to be counted for 
when performing hydraulic calculations.  
Do not locate nodes at conditional 
aspects because the maintenance of the 
geometric data will be a struggle and a 
punishment. 
 

In micro drainage (neighbourhood level) systems it is 
not applicable: 

• to locate nodes at conditional aspects like 
bridges or obstacles 

• to perform advanced hydraulic calculations. 
Calculations should be based on judgement of 
the condition and geometric data.   

 
In macro drainage (village/city level) systems it is 
more applicable: 

• to locate nodes where bridges or obstacles 
changes the cross section. 

• to perform advanced hydraulic calculations. 
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The visual inspection can be carried out in one of the following ways: 

• inspection of the not covered drainage from the surface; 

• inspection of covered drainage or culverts with mirrors or photographic camera 

• With a laptop, notebook or tablet computer. Installed on the computer the program BRUTIS 
with the drainage network, topography and Global Positioning System (GPS). The BRUTIS 
program employs the personnel with a system to register inventory and condition aspect 
locations, extends, characterisations, quantifications and photos.  

 
The inspection shall be carried out sufficiently slowly to enable all features to be observed. A 
photographic camera is used to register aspects.      
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3. Codes related to the inventory of drainage 
The tables in this section define the codes in the mutation-files and the headers in the CSV files. The key 
values are underlined. The minimum geometric data for assessing the condition and needed 
maintenance and operational problems are painted dark grey (orange). The minimum extra geometric 
data for assessing the hydraulic capacity are painted light grey (yellow).    
 
The tables C.1 through C.12 define the geometric 
data.  
 
The tables C.13 through C.15 define the condition 
data. 
 
The coding system related to the visual inspection of 
drainage is defined in section 4  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nodes   

FieldDescription        : rd_node 

   

CSV  Revision 

Node MutDate (yyyymmdd) CBF 

Node.MutTime (hhmmss) CBG 

Node ID                  CAA 

x (m)                    CAX 

y (m)                    CAY 

Quality coordinates      CKC 

Ground Level             CAC 

Quality Ground Level     CKM 

Chamber Floor Level      CAD 

Water Level              CFJ 

Chamber Shape            CAE 

Chamber Width (mm)       CAF 

Chamber Length (mm)      CAG 

Node Type                CAR 

Node Material            CCD 

Chamber Plan Area        CFG 

System Type              CCU 

Node Cover Type          CCO 

Node Flow Profile        CFH 

Node Construction        CFI 

Node Adresses            CZA 

Node Inflow (l/h)        CZB 

Head Loss coefficient    CZC 

Node Remarks             CDE 

 
Table C.1 

Conduits   

FieldDescription        : rd_pipe 

   

CSV  Revision 

Cond.MutDate (yyyymmdd) ABF 

Cond.MutTime (hhmmss) ABG 

US Node ID               AAD 

DS Node ID               AAF 

Conduit ID               AAZ 

Offset Distance (m)      AAY 

Conduit Type             ACJ 

System Type              ACK 

Year of Construction     ACN 

Conduit Material         ACD 

Shape ID                 ACA 

Joint Construction       ACO 

Soil Type                ACX 

Foundation Type          ACS 

US Invert Level (m AD)   ACH 

DS Invert Level (m AD)   ACI 

Quality Invert Levels    AKB 

Street Code              AAS 

Street Name              AAJ 

Street Type              ACR 

Pavement Type            ACQ 

Width                    ACC 

Height                   ACB 

Invert Width             ACP 

Length                   ACG 

Quality Length           AKL 

Bottom Roughness         ACV 

Top Roughness            ACW 

District Code            BOM 

District Name            AAO 

Inspection Date          API 
Year of Measure 
Review   AMO 

Tactical Measure         AMR 

Replacement direct (m)   AM1 

Replacement < 5 y. (m)   AM5 
Replacement < 10 y. 
(m)  A10 

No Replacement (m)       AM0 

No inspect/review (m)    NOI 

Operational Measure      APL 

Projectname              APW 

Replacement Cost         APC 

Conduit Remarks          ADE 
 
Table C.2 
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 Conduit points on poly line 

FieldDescription        : rd_trace 

   

CSV  Revision 

Cond.MutDate (yyyymmdd) ABF 

Cond.MutTime (hhmmss) ABG 

US Node ID               AAD 

DS Node ID               AAF 

Conduit ID               AAZ 

Pline X                  ATX 

Pline Y                  ATY 

Pline Z                  ATZ 
 
Table C.3 
 

Pumps 

FieldDescription        : hw_pump 

   

CSV  Revision 

Link Suffix              ACT 

Link Type                ACU 

Pump MutDate (yyyymmdd) PIZ 

Pump.MutTime (hhmmss) PIT 

US Node ID               PAD 

DS Node ID               PAF 

Pump ID                  PID 

Tag ID                   PNR 

Switch on Level          PUN 

Switch off level         PUF 

DS Switch on Level       PDN 

DS Switch off level      PDF 

Base level               PAB 

Discharge                PCA 

Pump Type                PMP 

Date Install.(yyyymmdd)  PDA 

Design                   PWU 

I/O Type                 PNI 

Year of construction     PJV 

Serial Number            PSE 

Impeller Type            PWA 

Impeller Dimension       PWD 

Demand                   PAV 

Voltage                  PSV 

Cos Phi 1-0              PAM 

Revs                     PRF 

Inominaal (mA)           PIN 

Oil Filling              POL 

Foot Rack                PVR 

Hour Meter               PUT 

Kwh Indicator            PKM 

Frequency Transvormer    PFO 

Telemetry                PTE 

Overhauld                PRV 

Disch. Necessary (l/s)   PNO 

Discharge 2010 (l/s)     P10 

Discharge 2020 (l/s)     P20 

Q/H1 Discharge (l/s)     PC1 

Q/H1 Water Level (m AD)  PN1 

Q/H2 Discharge (l/s)     PC2 

Q/H2 Water Level (m AD)  PN2 

Q/H3 Discharge (l/s)     PC3 

Q/H3 Water Level (m AD)  PN3 

Q/H4 Discharge (l/s)     PC4 

Q/H4 Water Level (m AD)  PN4 

Q/H5 Discharge (l/s)     PC5 

Q/H5 Water Level (m AD)  PN5 

Q/H6 Discharge (l/s)     PC6 

Q/H6 Water Level (m AD)  PN6 

Q/H7 Discharge (l/s)     PC7 

Q/H7 Water Level (m AD)  PN7 

Q/H8 Discharge (l/s)     PC8 

Q/H8 Water Level (m AD)  PN8 
 
Table C.4 
 

Electro Mechanical Installations 

FieldDescription        : rd_inst 

   

CSV  Revision 

Inst.MutDate (yyyymmdd)  IAZ 

Inst.MutTime (hhmmss)  IAT 

Installation Node Nr     INO 

Installation Name        INA 

Installation Number      IPO 

Installation Year        IJI 

Housing Year             IJK 

Phone Number             ITN 

Meter Number             IMN 

Location Meter           ILM 

Frequency Maintenance    IOF 

Town Name                IKR 

Installation Type        ITY 

Lock Type                ISL 

Control Type             IBS 

Installer                IIN 

Owner                    IEI 

Storage (m3)             IPB 

Housing Width (mm)       IKW 

Housing Heigth (mm)      IKH 

Housing Length (mm)      IKL 

Ann. Type Malfunction    IST 

Ann. Type Thermal        ITE 

Ann. Type Phase Gone     IFA 

Ann. Type High Water     IHO 

Ann. Type Low Water      ILA 

Overhaul Installation    IRV 

Date NEN3140             INE 
 
Table C.5 
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Weirs 

FieldDescription        : hw_weir 

   

CSV  Revision 

Link Suffix              ACT 

Shape ID                 ACA 

Link Type                ACU 

Weir MutDate (yyyymmdd) WIZ 

Weir.MutTime (hhmmss) WIT 

US Node ID               WAD 

DS Node ID               WAF 

Weir ID                  WID 

Crest                    WAH 

Weir Width               WAW 

Discharge Coefficient    WAC 

Flow Direction           WAL 
 
Table C.6 
 
 

Orifices 

FieldDescription        : hw_orifice 

   

CSV  Revision 

Link Suffix              ACT 

Shape ID                 ACA 

Width                    ACC 

Height                   ACB 

Link Type                ACU 

US Node ID               WAD 

DS Node ID               WAF 

Weir ID                  WID 

Discharge Coefficient    WAC 

Flow Direction           WAL 

Orif.MutDate (yyyymmdd)  WCZ 

Orif.MutTime (hhmmss)  WCT 

Invert Level             WBO 

Discharge Coefficient    WAO 

Limiting Discharge(l/s)  WCL 
 
Table C.7 
 

Catchments 

FieldDescription        : hw_subcatchment 

   

CSV  Revision 

Node ID                  CAA 

x                        CAX 

y                        CAY 

System Type              CCU 

US Node ID               AAD 

DS Node ID               AAF 

Subcatchment ID          CFI 

Total Area (ha)          CFT 

Contributing Area (ha)   CFC 
Closed Pav 
Steep(%/ha)   C01 

Closed Pav Flat(%/ha)    C02 
Closed Pav 
Stretc(%/ha)  C03 

Open Pav Steep(%/ha)     C04 

Open Pav Flat(%/ha)      C05 

Open Pav Stretc(%/ha)    C06 

Unpaved Steep(%/ha)      C07 

Unpaved Flat(%/ha)       C08 
Unpaved 
Stretched(%/ha)  C09 

Roof Steep(%/ha)         C10 

Roof Flat(%/ha)          C11 

Roof Stretched(%/ha)     C12 

Closed Pav Steep(m2)     M01 

Closed Pav Flat(m2)      M02 

Closed Pav Stretc(m2)    M03 

Open Pav Steep(m2)       M04 

Open Pav Flat(m2)        M05 
Open Pav 
Stretched(m2)   M06 

Unpaved Steep(m2)        M07 

Unpaved Flat(m2)         M08 

Unpaved Stretched(m2)    M09 

Roof Steep(m2)           M10 

Roof Flat(m2)            M11 

Roof Stretched(m2)       M12 
 
Table C.8 
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Gullies 

FieldDescription        : rd_con 

   

CSV  Revision 

Gull.MutDate (yyyymmdd) HAZ 

Gull.MutTime (hhmmss)    HAT 

Gully ID                 HAA 

Gully Street Name        HAJ 

x (m)                    HAX 

y (m)                    HAY 

Gully Type               HAR 

Gully Remarks            HDE 

Deposit weight           HDM 

Hand Cleaned             HA1 

Gully With Lock          HB4 

Gully Trap Not Present   HA2 

Cement In Gully          HA3 

Grease In Gully          HA4 

Bottom Is Defective      HA5 

Cover Is Defective       HA6 

Unable To Lift Cover     HA7 

Cover Not Present        HA8 

Gully Pipe Obstructed    HA9 

Settlement Of Gully      HB0 
Settlement Of 
Pavement   HB1 

Vehicle On Gully         HB3 

Not Cleaned              HB2 
 
Table C.9 
 
 

Connections between gullies 

FieldDescription        : rd_col 

   

CSV  Revision 

Conn.MutDate (yyyymmdd) SAZ 

US Gully ID              SAD 

DS Gully ID              SAF 

Connector Material       SCD 

Connector Width (mm)     SCC 

Connector Type           SCK 

US Invert Level (m AD)   SCH 

DS Invert Level (m AD)   SCI 

Year of Construction     SCN 
 
Table C.10 
 

Addresses 

FieldDescription        : rd_adr 

   

CSV  Revision 

Street Code              AAS 

Street Name              AAJ 

Adres Number             ONR 

Adres Letter             OLE 

Adres Addition           OAD 

Adres x (m)              OCX 

Adres y (m)              OCY 

Adres Type               OTY 

Adres Outflow (l/h)      OLH 
 
Table C.11 
 
 

Street names 

FieldDescription        : rd_str 

   

CSV  Revision 

Street Code              AAS 

Street Name              AAJ 
 
Table C.12 
 
 
 

Theme/Area/District names  

FieldDescription        : rd_bem 

   

CSV  Revision 

District Code            BOM 

District Name            AAO 

Colour number            LCO 

District Theme           MKL 
 
Table C.13 
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Inspection mutation file 

FieldDescription        : rd_rib 

   

CSV  Revision 

Inspection File ID       RIB 

Inspection FileName      AIF 

Number of Inspections    INS 

Number of Results        RES 

Number of Images         IMA 

Company Name   ABH 
 
Table C.14 
 
 

Inspections 

FieldDescription   : rd_ins 

   

CSV  Revision 

US Node ID               AAD 

DS Node ID               AAF 

Conduit ID               AAZ 

Inspection File ID       RIB 

Inspection ID            AID 

Insp.Date (yyyymmdd)     XBF 

Insp.MutTime (hhmmss)    XBG 

Inspection Type          ABE 

Inspection Remarks       ZZP 

Node Reference           AAK 
 
Table C.15 
 
 

Inspection results 

FieldDescription      : rd_res 

   

CSV  Revision 

Inspection File ID       RIB 

Inspection ID            AID 

Node Reference           AAK 

Axial begin location     AAH 

Axial end location       AAI 

Radial begin location    KL1 

Radial end location      KL2 

Damage Type              XBE 

Classification           KAC 

First characteristic     KA1 

Second characteristic    KA2 

Picture FileName         ABN 

Video FileName           ABO 

Video Position           ABM 

Kwantification 1         KW1 

Kwantification 2         KW2 

Status         STS 
 
Table C.16 
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4. Codes related to the visual inspection of drainage 
 
This section defines the coding system for the visual inspection.  How to perform visual inspection is 
documented in chapter 6.2.  
 
The coding system is based on the European Standard EN 13508-2 and is made practical for use with 
drainage. 
 
For sewer systems BRUTIS uses an extended coding system based on the European Standard. 
 
The tables C.21 through C.39 define the coding system for visual inspection of the drainage. The 
aspects are observed with:  

• the characterisation and quantification code (column: C1 and C2) of aspects; 

• the location and extends of the aspects along the alignment measured from a node; 

• Optional: 
o a measure of the aspects (in mm, for example the height of settled deposits) 
o a photographic picture to visualize the aspect 

 
BRUTIS adds automatically the seriousness (column: S) of aspects. The seriousness and the extend of 
aspects are used in the decision support system for rehabilitation and the maintenance planning. 
 
The tables C.13 through C.15 define the condition data. 
 
 

Aspect:    Fissure 

     

Code S C1 C2 Description 

BAB 1 0 0 no fissure detected 

 2 A 0 surface crack 

 4 B 0 visible crack on the conduit wall 

 5 C 0 fracture or visibly open crack in a conduit wall 

     

Example:     

BAB 4 B 0 

 

    

 

Table C.21 
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Aspect:  Break or collapse 

     

Code S C1 C2 Description 

BAC 1 0 0 no break or collapse detected 

 2 A 0 pieces of conduit visibly displaced but not missing 

 4 B 0 missing pieces of wall 

 5 C 0 complete loss of structural integrity 

     

Example:     

BAC 4 B 0 

     

     

Example:     

BAC 5 C 0 

     
Table C.22 
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Aspect: Defective brickwork 

     

Code S C1 C2 Description 

BAD 1 0 0 no defective brickwork or masonry detected 

 2 A 0 displaced 

 3 B 0 missing 

 4 C 0 dropped invert 

 5 D A collapse 

     

Example:     

BAD 3 B 0 

     
Table C.23 
 
 

Aspect:  Missing Mortar 

     

Code S C1 C2 Description 

BAE 1 0 0 no missing mortar detected 

 2 0 0 mortar depth <= 10 mm 

 3 0 0 10 mm < mortar depth <= 20 mm 

 4 0 0 20 mm < mortar depth <= 40 mm 

 5 0 0 mortar depth > 40 mm 

     

Example:     

    

No example of missing mortar 
 
 
 
 
 
 
 

     
Table C.24 
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Aspect:  Surface damage 

     

Code S C1 C2 Description 

BAF 1 0 0 no surface damage detected 

 2 A 0 increased roughness 

 2 B 0 breaking away of small fragments 

 2 C 0 visible aggregate 

 2 J 0 corrosion products on surface 

 3 D 0 aggregate projecting from surface 

 3 F 0 visible reinforcement 

 4 E 0 missing aggregate 

 4 G 0 reinforcement projecting from surface 

 5 H 0 corroded reinforcement 

 5 I 0 missing wall 

     

Example:     

BAF 3 D 0 

     
Table C.25 
 

Aspect: Intruding connection 

     

Code S C1 C2 Description 

BAG 1 0 0 length of intrusion <= 10% height of conduit 

 3 0 0 10% < length of intrusion <= 25 % height of conduit 

 5 0 0 length of intrusion > 25% height of conduit 

     

Example:     

 BAG 5 0 0 

     
Table C.26 
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Aspect: Defective connection 

     

Code S C1 C2 Description 

BAH 1 0 0 no defect detected 

 2 A 0 the position of the connection is incorrect 

 3 B 0 there is a gap between end of connection and conduit 

 3 C 0 there is a gap around connection 

 4 D 0 the connection is damaged 

 5 E 0 the connection is blocked 

     

Example:     

BAH 2 A 0 

     
Table C.27 
 
 

Aspect:  Defective repair 

     

Code S C1 C2 Description 

BAL 1 0 0 no defective repair detected 

 2 A 0 part of the wall is missing 

 3 B 0 a deliberately made hole has become defective 

 5 Z 0 other 

     

Example:     

    

No example of defective repair 
 
 
 
 
 
 
 
     

Table C.28 
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Aspect:    Vegetation 

     

Code S C1 C2 Description 

BBA 1 0 0 no Vegetation detected 

 2 0 0 reduction cross-sectional area <= 10% 

 3 0 0 10% < reduction cross-sectional area <= 25% 

 4 0 0 25% < reduction cross-sectional area <= 50% 

 5 0 0 reduction cross-sectional area > 50% 

     

Example:     

BBA 5 0 0 

     
Table C.29 
 
 

Aspect:  Settled deposits 

     

Code S C1 C2 Description 

BBC 1 0 0 reduction cross-sect area <= 5% 

 2 0 0 5% < reduction cross-sect area <= 10% 

 3 0 0 10% < reduction cross-sect area <= 25% 

 4 0 0 25% <  reduction cross-sect area <= 50% 

 5 0 0 reduction cross-sect area > 50% 

     

Example:     

BBC 4 0 0 

     
Table C.30 
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Aspect:   Ingress of soil 

     

Code S C1 C2 Description 

BBD 1 0 0 no ingress of soil detected 

 2 0 0 reduction cross-sectional area <= 5% 

 3 0 0 5% < reduction cross-sectional area <= 15% 

 4 0 0 15% < reduction cross-sectional area <= 25% 

 5 0 0 reduction cross-sectional area > 25% 

     

Example:     

BBD 5 0 0 

     
Table C.31 
 
 

Aspect:  A Bridge Culvert 

     

Code S C1 C2 Description 

BEB 1 0 0 reduction cross-sectional area <= 5% 

 2 0 0 5% < reduction cross-sectional area <= 10% 

 3 0 0 10% < reduction cross-sectional area <= 25% 

 4 0 0 25% <  reduction cross-sectional area <= 50% 

 5 0 0 reduction cross-sectional area > 50% 

     

Example:     

BEB 2 0 0 

     
Table C.32 
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Aspect:  Other obstacles 

     

Code S C1 C2 Description 

BBE 1 0 0 reduction cross-sectional area <= 5% 

 2 0 0 5% < reduction cross-sectional area <= 10% 

 3 0 0 10% < reduction cross-sectional area <= 25% 

 4 0 0 25% <  reduction cross-sectional area <= 50% 

 5 0 0 reduction cross-sectional area > 50% 

     

Example:     

BBE 3 0 0 

     
Table C.33 
 
 

Aspect:    Infiltration 

     

Code S C1 C2 Description 

BBF 1 0 0 no ingress of water through the wall or joints detected 

 2 A 0 sweating - slow ingress of water - no visible drips 

 3 B 0 dripping - dripping in - not continuous flow 

 4 C 0 flowing - a continuous flow 

 5 D 0 gushing - entering under pressure 

     

Example:     

    

No example of infiltration 
 
 
 
 
 
 
 
     

Table C.34 
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Aspect:   Exfiltration 

     

Code S C1 C2 Description 

BBG 1 0 0 no visible leak detected 

 5 0 0 visible leak of flow out of the conduit 

     

Example:     

    

No example of exfiltration 
 
 
 
 
 
 
 

     
Table C.35 
 
 

Aspect:   Photograph 

     

Code S C1 C2 Description 

BDA 1 0 0 General photograph 

     
Table C.36 
 
 

Aspect:    Remarks 

     

Code S C1 C2 Description 

BDB 1 0 0 General remark 

     
Table C.37 
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Aspect:   Water level 

     

Code S C1 C2 Description 

BDD 1 0 0 height <= 10% of cross-section height 

 2 0 0 10% < height <= 25%  of cross-section height 

 3 0 0 25% < height <= 50% of cross-section height 

 4 0 0 50% < height <= 75% of cross-section height 

 5 0 0 height > 75% of cross-section height 

     

Example:     

BDD 5 0 0 

     
Table C.38 
 
 

Aspect:   Loss of vision 

     

Code S C1 C2 Description 

BDG 1 A 0 bridge, culvert or slab 

 1 B 0 silt 

 1 Z 0 other, details should be recorded in remarks section 

     

Example:     

BDG 1 A 0 

     
Table C.39 
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An important feature of BRUTIS is the ability to import geometric data, and convert data form the 
geometry to a BRUTIS Model. This feature makes it easy for a user to import data sets and start 
using BRUTIS immediately. 
  

In this example: Converting data from SHP files to data in BRUTIS work file. Adding data from old 
BRUTIS work files and importing inspection data from KML and CSV file. 
 
Example: Re-inventory of sewerage management data Kampot 
Received: SHP- file containing the results of a sewer re-inventory. The assignment is to convert 
these results into a BRUTIS work file.  Add data not in SHP-files and available inspection data.  
 
This can be done in the following steps: 

1. Assess data; 
2. Start BRUTIS64.exe and open/create mutation file; 
3. Transfer of data from source file 1 (nodes); 
4. Transfer of data from source file 2 (conduit); 
5. Save the result in a work file or database; 
6. Create work file with data not in SHP-files and add to the data obtained from the SHP-

files; 
7. Add inspection-data from KML, to link photos to nodes; 
8. Add inspection data from CSV, to link condition data and photos to nodes. 

 
1. Assess data: 
 

a.  Place the zip file in a folder, for example as below, at brutis64.exe 

b. Then extract the zip file. It contains shapefiles (SHP files): KP_Conduits and KP_Nodes. 
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c. Open the .dfb files with, for example, MS-Excel and assess what data is included with the 

node and conduit geometry SHP files. Find out where the node numbers are. And under 
which column is what. 
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2. Start BRUTIS64.exe and open/create mutation file: 
 

a. Run BRUTIS64.exe. Tab: Directory or File. Don't choose a file to start without data. Click 
button: [OK] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. The management window is started, without data: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

c. Open a mutation file to add and mutate data, via menu option: Mutation->Show 
mutations from file…. The “Make mutation file” window appears, with which you can 
choose a location and name of the file, with extension . mut. Click button: [Open] to open 

or create the mutation file.  
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d.  You will then be given the opportunity to 
enter basic data and default values. Entry 

is not required. Click [OK] 
 
From now on, all mutations according to 
the EN13508 coding system will be 
stored in this file. 

 
 
 
 
 
 

 
3. Importing the nodes from SHP-File: KP_Nodes (always the nodes first, if available) 

 
a. Start menuoption: Import->GML, DXF of SHP Topography”, to Import the geometry from 

SHP file: KP_Nodes. 
 
 
 
T
h
e
 
“
I
m
p
o
The “Import DXF or SHP file” window appears, go to the location where you can find the 
SHP-File, select it and import the geometry from the file with the [Open] button. 

 
b. When importing geometry from 

SHP files, the program displays a 
window that allows you to indicate 
which column determines the 
layer name of the geometry. So 
that you can later select geometry 
on this layer name. In the adjacent 
window, the column: Type, is used 
to extract the layer name. 
 
It is not mandatory to indicate 
layer name. You can also leave the 
field blank. The same goes for the 
other fields. It is useful to indicate 
a thickness, so that the knots are 
immediately visible. Start the 
import with the [OK] button. 

 
c. The node geometry has been imported:  
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d. Select the geometry from which the data should be taken. This can be done via menu 

option: Select -> Select Geometry -> With Filter… 
 

And click button: [Add all items to filter] in the “Select geometry” window, to select all 
manhole geometry. This one turns yellow. Close the window with button: [Close]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 It is also possible to select geometry within a polygon. To do this, first draw a polygon 

using button:  and button:  to close the polygon. You also close the polygon 
with a double click on the before last polygon point. And then menu option: Select -> 
Select Geometry -> Select geometry in polygon… 

  
e. Click menu option: Mutation -> Take over mutation from selected geometry -> Nodes… , 

to extract the nodes from the selected geometry. 
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Click: [Yes], to transfer the data of selected 
geometry to the nodes. 

 
 
 
 
 
 

 Click: [Yes], to add nodes from geometry. 
 
 
 
 
 

 
 
 For the BRUTIS fields, choose the correct 
columns from the SHP file. So that the data 
from the SHP-File ends up in the correct 
BRUTIS data field. 
 
If dimensions are specified in meters in the 
SHP file, these can be converted to mm via 
the “$Dimensions multiply by” factor, by 
entering the value 1000 here. 
 
Click: [OK], as soon as, as many BRUTIS 
data fields as possible have been provided 
with the columns from the SHP-File.    

 
 
 
 
 
 
 
 
 

 Click: [Yes], to save the choices in the 
integration file. The integration file is 
saved with the SHP-File, ready to 
automatically populate the integration 
window next time. Or to use for an 
automated conversion of data, with a 
bacth-file. 
 

 
f. The result with WMS/WMTS Streetmap button checked, registration of the location of the 

images in start option: images, and the via button: , consult of a node: 
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4. Importing the conduit from SHP-File: KP_Conduits 

 
a. Start menu option: Import -> GML, DXF of SHP Topografie, to Import the geometry from 

SHP file: KP_Conduits.  
 
The “Import DXF or SHP file” window appears, with which you can find the SHP-File, 
select it and import the geometry from the file with the [Open] button. 

 
 
 
 
 
 

 
 

b. When importing geometry from 
SHP files, the program displays a 
window that allows you to 
indicate which column 
determines the layer name of 
the geometry. So that you can 
later select geometry on this 
layer name. In the adjacent 
window, the column: Type, is 
used to extract the layer name.  
 
It is not mandatory to indicate 
layer name. You can also leave 
the field blank. The same goes 
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for the other fields. It is useful to indicate a thickness and a different colour, so that the 
conduits are immediately visible. Start the import with the [OK] button. 

 
c. The conduit geometry has been imported:  

 
 
 
 
 
 
 
 
 
 
 
 

d. Select the geometry from which the data should be taken. First of all, by turning off the 
geometry with the nodes by removing the check mark in front of the file name in the 
topography bar. 
 
 
 
 
 
 

Then select the conduit geometry via menu option: Select -> Select Geometry -> With 
Filter… 

 
And click button: [Add all items to filter] in the “Select geometry” window, to select all 
conduit geometry. These turns yellow. Close the window with button: [Close]. 
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 It is also possible to select geometry within a polygon. To do this, first draw a polygon via 

the button:  and then button:  to close the polygon. You also close the 
polygon with a double click on the before last polygon point. And then menu option: 
Select -> Select Geometry -> Select geometry in polygon… 

  
 

e. Click menu option: Mutation -> Take over mutation from selected geometry -> 
Conduits… , to extract the conduits from the selected geometry. 

 
 

Click: [Yes], to transfer the data of selected geometry to the conduit. 
 

Click: [Yes], to add conduits from geometry. 
 
 For the BRUTIS fields, choose the correct columns 
from the SHP file. So that the data from the SHP-
File ends up in the correct BRUTIS data field. 
 
When converting the conduits, BRUTIS searches for 
nodes that can be connected based on the start 
and end coordinates of the conduit geometry. 
Factor: “$ Node Search distance [m]”, is used here. 
Only nodes within this distance are linked. If a 
node is not present, it will be created. If no “From 
Node no” and “To node no” are specified, the 
program creates new node numbers starting with 
the letter indicated after start option: letter.  
 
If dimensions in cm are specified in the SHP file, 
these can be converted to mm via the 
“$Dimensions multiply by” factor, by entering the 
value 10 here. 
 
Click: [OK], as soon as, as many BRUTIS data fields 
as possible have been provided with the columns 
from the SHP-File.    

 
Click: [Yes], to save the choices in the integration 
file. The integration file is saved with the SHP-File, 
ready to automatically populate the integration 
window next time. Or to use for an automated 
conversion of data. 

 
f. On the next page the image with the result with 
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WMS/WMTS Streetmap button checked and consulting the conduit, via button: . 
 

g.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If in the invert levels of the conduits are missing, BRUTIS uses the node invert levels for the 
registration of the conduit invert levels. 

 
 
5. Store the results in a work file or database 

 
a. Save to a work-file via menu option: File -> Save As -> Work-File, so that the data obtained 

can be opened and viewed immediately from now on. 

 
Or  
 
 If a database is available. Via menu option: 
Mutation -> Move mutation to database -> 
Check mutations.   
 
After entering the database connection data, 
BRUTIS connects to the database and checks 
whether the changes can be implemented. 
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After this menu option:  Mutation -> Move mutation to database -> Move mutation to 
database, to store the data in the database. 

 
 
6. Create work file with data not in SHP-files and add to the data obtained from the SHP-files 
 
the light blue lines in the view below represent the conduits obtained from the SHP file. Not in the SHP-
files is the data of a pumping station, rising main (purple) to a waste water treatment plant and some 
conduits on the other side of the river (brown). The data of these objects is in another work file and we 
want to add it to the data.  

 
 

a. Start BRUTIS with the other work file with the 
extra data above.  
 

b. Select the parts above, by drawing a polygon 

around those parts, using the button:  , 
and double click to close the polygon. Select the 
objects in the polygon with menu option:  Select 
-> Select Object in polygon -> All Objects. Until 
all to be added objects are coloured orange.  
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c. Copy the selected objects to the clipboard, with menu option: Tools -> Copy to Clipboard. 

 
d. Open a new window with men option: File -> New.  

 
e. And paste from clipboard, with menu option: Tools -> Paste from Clipboard. 

 
f. Save to a work-file via menu option: File -> Save As -> Work-File, so that the data obtained 

can be imported in the work-file with the data obtained from SHP-files. 
 

g. Exit BRUTIS and restart with the data obtained from the SHP-files: 
 

 
 

h. The data obtained from SHP-files in the previous steps: 
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i. Add the pumping station, rising main,  waste water treatment plant from the other work-file, 

with menu option: Import -> Work file. 
 

 
 

j. Select the working file and click [Open]. And in the subsequent dialog, click [Yes] to merge 
the networks of both work files. 
 

 
 

k. The merged data is shown below: 
 
 

 
 
 
Don’t forget to save the merged data in a new work file. 
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7. Add inspection-data from KML 
There is a KML file available with photos of nodes.  In this step we connect the photos to the nodes in 
the work file by importing the KML as topography and match the nodes in the KML with the nodes in the 
work file by using the coordinates. 
 
Via menu option: Tools -> Start options, it is important to set a match distance and to set the option to 
avoid replacing nodes coordinates with coordinates from the KML. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
a. Import the KML as topography, with menu option: Import -> GML, DXF or SHP 

Topography. 
 

 
 

b. Select the KML file. And Click [Open]. 
 

c. dialog appears that allows you to set the colour and thickness of the topography to be 
imported. In this example we choose a grey colour with a thickness of 10 pixels.hat the 
data obtained can be opened and viewed immediately from now on. 

 
 
Option: matchdis sets the distance for 
matching coordinates in the KML with 
coordinates of nodes in the work file. 

 
 
Option: nomove=1, avoids the replacement 
of node coordinates by the coordinated in 
the KML, because the coordiantes in the 
KML are not precise.  
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e. Open a mutation file to catch all KML inspection data, via menu option: Mutation->Show 

mutations from file…. The “Make mutation file” window appears, with which you can 
choose a location and name of the file, with extension . mut. Click button: [Open] to open 

or create the mutation file.  
 

 
 

f. You will then be given the opportunity to enter 
basic data and default values. Entry is not 

required. Click [OK] 
 

d. Select the geometry from which the data should 
be taken. This can be done via menu option: 
Select -> Select Geometry -> With Filter… 

 
And click button: [Add all items to filter] in the 
“Select geometry” window, to select all 
manhole geometry.  These turns yellow. Close 
the window with button: [Close]. 
 

 

 
 
The grey dots from the KML and the nodes 
and conduits. 
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e. Click menu option: Mutation -> Take over mutation from selected geometry -> Nodes… , 
to extract the inspections from the selected geometry. 
 

f. The program starts a dialog: whether you 
want to accept data from the selected 
geometry [Yes], to accept inspection data. 
Whether you want to add data [No] Do not 
add nodes from KML. And finally, whether 
you want to import the inspection data 
[Yes]. To import the inspection data. 
 

g. The result is shown on the next page. The 
inspected nodes have a purple colour. 

 
 

 

 Yes 
 
 

 
No 
 
 

 Yes 
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You can consult the inspection data by clicking on a node after the button: , after which the data of 
the node will be displayed. Below the data you will find the button: [Logbook], to display the inspection 
data. In the log window you can click on a status aspect to view photos. 
 

 
 
 

h. Don’t forget to save the merged data in a new work file. 
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i. And add the inspection data in the export to work file 
 

 
 

j. [Yes]. 
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8. Add inspection data from CSV 
 
Before you import data from CSV, it is wise to view the data via MS Excel. To get an idea of what data is 
involved. In this case it contains rules recording the dimensions and bob levels of connected pipes and 
the quality of the well cover with photo file names. 
 

 
 
 
You can import a huge amount of data via CSV and SHP and link it to existing data. Much more than at 
KML. 
 
If you do not want to copy coordinates from the CSV, it is also important to give start option: nomove 
the value 1, via menu option: Tools -> Start options.  To disable the replacement of coordinates from 
import data. 
 
 

a. Import the CSV data, via menu option: Import -> CSV Object data -> Start. 
 

 
b. Select the file and click [Open] 
c. If the column headings are unknown, the program will ask for the data type in the next 

window. 
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d. Click on the nodes checkbox to indicate that 
it concerns node data. And then click the 
[OK] button. 

e. The window will then appear in which you 
can indicate how the data from the CSV file 
should be processed. And what the 
matchdis parameter is to link the node date 
to the existing nodes. 

f. Almost at the bottom you will find the Well-
known test (WKT) field, behind which you 
register the "geometry" column from the 
CSV file. 

g. Click: [OK], as soon as, as many BRUTIS data 
fields as possible have been provided with 
the columns from the SHP-File.    

h. Click: [Yes], to save the choices in the 
integration file. The integration file is saved 
with the SHP-File, ready to automatically 
populate the integration window next time. 
Or to use for an automated conversion of 
data. 
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i. If inspection data is found the program ask’s if 
the data should be imported. Click [Yes]. 

j. You can see the results below. Via the menu 
option: Select -> Via filter -> nodes, you start a 
window with which you can select the quality 
of nodes via the tab: Aspect. 

 
 
 
 

 
 
 

You can consult the inspection data by clicking on a node after the button: , after which the data of 
the node will be displayed. Below the data you will find the button: [Logbook], to display the inspection 
data. In the log window you can click on a status aspect to view photos. 
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k. Don’t forget to save the merged data in a new work file. 
 

 
 
 

l. And add the inspection data in the export to work file 
 

 
 

m. [Yes]. 
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When no tables found BRUTIS creates automatically the next urban drainage management tables:   
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